Garden Designer Help Index

General Description

Structure of a Garden Document:
Plan Window
Encyclopedia Window
Care Window
Notes Window

How To ...
Manage plant species:
Change the current plant species
View care calendar for current plant species
View possible diseases for current plant species
View and edit note text for current plant species

Manage plan objects:
Place an object in a garden plan
Select an object or group of objects
Transform an object
View and change the properties of an object
View and edit note text for an object
Make a copy of an object

Commands
File menu
Edit menu
Place menu
Plant menu
View menu
Window menu

Help menu




File menu commands

The File menu offers the following commands:

New Creates a new document.

Open Opens an existing document.

Close Closes an opened document.

Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.

Print Setup Selects a printer and printer connection.

Load on Startup  Toggles the loading of the most recently opened file on startup.

Xit Exits Garden Designer.
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Load on Startup command (File menu)

This command turns on or off the loading of the most recently opened garden document.

If the menu item is checked, then Garden Designer will load the last used document next time the
program is started up.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.

Redo Redo last undone operation

Cut Deletes data from the document and moves it to the clipboard.
Co Copies data from the document to the clipboard.

Delete Deletes selected objects

Paste Pastes data from the clipboard into the document.

Deselect Deselects object or group of object

Select All Selects all the items within a document

Paste Link Pastes from the clipboard a link to data in another application.
Insert New Inserts and embeds an object, such as a chart or an equation in a document.
Obiject

Links List and edit links to embedded documents.

Obiject Activate an embedded object for editing.

Deselect command (Edit menu)

Use this command to deselect an object or group of objects in the Plan window



Delete command (Edit menu)

Use this command to delete currently selected objects.



Select All command (Edit menu)

Use this command to select all the objects within a garden plan.



View menu commands

The View menu offers the following commands:

Main Toolbar Shows or hides the main toolbar.
Plan Toolbar Shows or hides the plan toolbar.
Rulers Shows or hides the plan rulers
Status Bar Shows or hides the status bar
Plan Options Set garden plan view options
Background Set garden plan background

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple
documents in the application window:

Duplicate Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.

Tile Horizontal Horizontally arranges windows in non-overlapped tiles.
Tile Vertical Vertically arranges windows in non-overlapped tiles.

Arrange Icons Arranges icons of minimised windows.
Synchronize by  Synchronize all document views to show the same plant species.

Plan Activate plan window of current document.

Care Activate care window of current document.

Notes Activate notes window of current document.
Encyclopedia Activate encyclopedia window of current document.
Window 1, 2, ... Goes to the specified window.

Synchronize by Plant command (Window menu)

Use this command to set synchronization mode of document windows. Having this turned ON
synchronizes all document views to show the same plant species; turned OFF, each window behaves
independently of the others.

Shortcuts
Keys: CTRL+F9



Plan command (Window menu)

Use this command to activate the Plan window of the current document
See Plan Window for more information about editing a garden plan.

Shortcuts

Main Toolbar:

Keys: Alt+1



Care command (Window menu)

Use this command to activate the Care window of the current document
See Care Window for more information about the garden care window

Shortcuts

Main Toolbar: @

Keys: Alt+3



Notes command (Window menu)

Use this command to activate the Notes window for the current document
See Notes Window for more information about the notes window

Shortcuts

Main Toolbar:

Keys: Alt+4



Encyclopedia command (Window menu)

Use this command to show the encyclopedia window.
See Encyclopedia Window for more information about the plant encyclopedia.

Shortcuts

Main Toolbar:

Keys: Alt+2



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application:

Index Offers you an index to topics on which you can get help.
Using Help Provides general instructions on using help.
Context Help Provides help on a specific Garden Designer object.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new document in Garden Designer.
You can open an existing document with the Open command.

Shortcuts

Toolbar:

Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document in a new window. You can open multiple documents at
once. Use the Window menu to switch among the multiple open documents. See Window 1, 2, ...
command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open.

List Files of Type
Select the type of file you want to open: i.e. *.GRD

Drives

Select the drive for which Garden Designer displays a file list.
Directories

Select the directory for which Garden Designer displays a file list.
Network...

This button is available if you are running Windows for Workgroups 3.11 or Windows 95.
Choose this button to connect to a network location, assigning it a new drive letter.



Close command (File menu)

Use this command to close all windows containing the active document. Garden Designer suggests that
you save changes to your document before you close it. If you close a document without saving, you
lose all changes made since the last time you saved it. Before closing an untitled document, Garden
Designer displays the Save As dialog box and suggests that you name and save the document.

You can also close a document by using the Close icon on the document’s window, as shown below:




Save command (File menu)

Use this command to save the active document with its current name and directory. When you save a
document for the first time, Garden Designer displays the Save As dialog box so you can name your
document. If you want to change the name and directory of an existing document before you save it,
choose the Save As command.

Shortcuts

Main toolbar:

Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document. Garden Designer displays the Save As
dialog box so you can name your document.

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you are about to save:

File Name
Type a new filename to save a document with a different name. A filename can contain up to eight
characters and an extension of up to three characters. Garden Designer adds the extension
specified in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you
closed. Choose the number that corresponds with the document you want to open.



Exit command (File menu)

Use this command to end your Garden Designer session. You can also use the Close command on the
application Control menu. Garden Designer prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application’s Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.

Shortcuts

Toolbar:

Keys: CTRL+Z or
ALT-BACKSPACE



Redo command (Edit menu)

Use this command to redo the last undone operation, if possible.

Shortcuts

Toolbar:

Keys: CTRL+A



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on the clipboard.
This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Main toolbar:

Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard. This command is unavailable if there is no
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

ER,
Main toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point. This command is
unavailable if the clipboard is empty.

Shortcuts
Main toolbar: =
Keys: CTRL+V



Main toolbar command (View menu)

Use this command to display and hide the Main toolbar, which includes buttons for some of the most
common commands in Garden Designer, such as File Open. A check mark appears next to the menu
item when the Main toolbar is displayed.

See Main Toolbar for help on using the main toolbar.



Plan toolbar command (View menu)

Use this command to display and hide the Plan toolbar of currently active plan window. This toolbar
includes buttons for some of the commands in the garden plan, such as Edifice, Decor etc... A check
mark appears next to the menu item when the Plan toolbar is displayed.

See Plan Toolbar for help on using the plan toolbar.



Rulers command (View menu)

Use this command to display and hide the Rulers of the currently active plan window. A check mark
appears next to the menu item when the Rulers are displayed.

See Rulers for help on using the rulers.



Background command (View menu)

Use this command to choose the background of the garden plan.

The command displays the Plan Background dialog.



Main Toolbar
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The main toolbar is displayed across the top of the application window, below the menu bar. The main
toolbar provides quick mouse access to many tools used in Garden Designer,

To hide or display the main toolbar, choose Main toolbar from the View menu (ALT, V, T).

Click To

E- Open an existing document. Garden Designer displays the Open dialog box, in which you can
locate and open the desired file.

Save the active document with its current name. If you have not named the document, Garden
Designer displays the Save As dialog box.

Remove selected data from the document and store it on the clipboard.

Copy the current selection to the clipboard.
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Insert the contents of the clipboard at the insertion point.
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Reverse the last action. Note: You cannot undo some actions.
Redo the previous undo action.

Activate Plan window for the current document.

Activate the Encyclopedia window.

Activate Care window for the current document.
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Activate Notes window for the current document.

Show Care Calendar for current plant species.
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View and edit note text for current plant species.
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View list of possible plant diseases for current plant species.



Print the active document.

Display context sensitive help for a selected object.



Plan Toolbar
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The plan toolbar is displayed across the top of the plan window, below the title bar. The plan toolbar
provides quick mouse access to many tools used in the plan window.

To hide or display the plan toolbar, choose Plan toolbar from the View menu (ALT, V, P).

Click To

Place surface object in plan
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Place edifice object in plan

0

Place a fencing object in plan

Place a decor object in plan

Place a lantern object in plan
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Place a vehicle object in plan
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Place a plant object in plan

Select month for which to display garden colours, (or All colours).

View and change garden plan options

Zoom out of garden display
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Zoom into garden display

View garden plan during day time

® &

View garden plan during night time



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the
selected menu item or depressed toolbar button, along with the current cursor location. A check mark
appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

ForHelp, press F1 x=-16.0m |y= -5.0m

The status bar is displayed at the bottom of the Garden Designer window. To display or hide the status
bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate
through menus. This area similarly shows messages that describe the actions of toolbar buttons as you
depress them, before releasing them. If after viewing the description of the toolbar button command you
wish not to execute the command, then release the mouse button while the pointer is off the toolbar
button.

The far right of the status bar shows the X and Y co-ordinate of cursor, angle, or dimensions of an object
depending on the current operation.



Rulers

The rulers are displayed around the top and left sides of the Plan window. To display or hide the rulers,
use the Rulers command in the View menu.

Click & drag on a ruler to add guidelines for aligning objects and the like. Drag guidelines back to a ruler
to delete them.

Click and drag on top left corner of the ruler to change the origin of co-ordinates.



Duplicate command (Window menu)

Use this command to open a new window with the same contents as the active window. You can open
multiple document windows to display different parts or views of a document at the same time. If you
change the contents in one window, all other windows containing the same document reflect those
changes. When you open a new window, it becomes the active window and is displayed on top of all
other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Arrange Ilcons Command (Window menu)

Use this command to arrange the icons for minimized windows at the bottom of the main window. If
there is an open document window at the bottom of the main window, then some or all of the icons may
not be visible because they will be underneath this document window.



1, 2, ... command (Window menu)

Garden Designer displays a list of currently open document windows at the bottom of the Window menu.
A check mark appears in front of the document name of the active window. Choose a document from

this list to make its window active.



Index command (Help menu)

Use this command to display the Help contents screen. From the opening screen, you can jump to step-
by-step instructions for using Garden Designer and various types of reference information.

Once you open Help, you can click the Contents button whenever you want to return to the opening
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version humber of your copy of Garden Designer.



Context Help command

Use the Context Help command to obtain help on some portion of Garden Designer. When you choose
the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark. Click
somewhere in the Garden Designer window, such as another Toolbar button, and a Help topic will be
shown for the item you clicked on.

Shortcut
h?

Main Toolbar:

Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window. It contains the name of the application and document.

To move the window, drag the title bar. Note: You can also move dialog boxes by dragging their title
bars.

A title bar may contain the following elements:

. Application Control-menu button
. Document Control-menu button
. Maximize button
- Minimize button

Name of the application
. Name of the document
. Restore button



Scroll bars

Displayed at the right and bottom edges of the document window. The scroll boxes inside the scroll bars
indicate your vertical and horizontal location in the document. You can use the mouse to scroll to other
parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

&

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the
border you want to move.

2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note: This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with
the arrow keys.

&

Note: This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Garden Designer window to an icon.

Shortcut

Mouse: Click the minimize icon IZI on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill all the available space.

Shortcut

Mouse: Click the maximize icon E on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window. Garden Designer determines which
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note: If you have multiple windows open for a single document, the Close command on the document
Control menu closes only one window at a time. You can close all windows at once with the Close
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window
ALT+F4 closes the Garden Designer window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications. Use the "Task List" to switch to or close an
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following
options:
Task List
Select the application you want to switch to or close.
Switch To
Makes the selected application active.
End Task
Closes the selected application.
Cancel
Closes the Task List box.
Cascade
Arranges open applications so they overlap and you can see each title bar. This option does not
affect applications reduced to icons.
Tile
Arranges open applications into windows that do not overlap. This option does not affect
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Fit to size command (Control menu)

This command resizes the window so, that all the controls of it are visible.

If size of document window fits the controls layout, the command is unavailable.






Print command (File menu)

Use this command to print a document. This command presents a Print dialog box, where you may
specify the range of pages to be printed, the number of copies, the destination printer, and other printer

setup options.

Shortcuts

Toolbar:

Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:

Printer
This is the active printer and printer connection. Choose the Setup option to change the printer and
printer connection.

Setup
Displays a Print Setup dialog box, so you can select a printer and printer connection.
Print Range
Specify the pages you want to print:
All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality
Select the quality of the printing. Generally, lower quality printing takes less time to produce.



Print Progress Dialog

The Printing dialog box is shown during the time that Garden Designer is sending output to the printer.
The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed. When you choose
this command, the main window will be replaced with a print preview window in which one or two pages
will be displayed in their printed format. The print preview toolbar offers you options to view either one or
two pages at a time; move back and forth through the document; zoom in and out of pages; and initiate a

print job.



Print Preview toolbar

The print preview toolbar offers you the following options:

Print
Bring up the print dialog box, to start a print job.
Next Page
Preview the next printed page.
Prev Page
Preview the previous printed page.
One Page | Two Page
Preview one or two printed pages at a time.

Zoom In
Take a closer look at the printed page.

Zoom Out
Take a larger look at the printed page.

Close
Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection. This command presents a Print Setup
dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use. Choose the Default Printer; or choose the Specific Printer option
and select one of the current installed printers shown in the box. You install printers and configure
ports using the Windows Control Panel.

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources. Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to the type of
printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.






Paste Link command (Edit menu)

Use this command to paste and link an object from another OLE server application.
Changes made to an object in the source document will be reflected in your Garden Designer document.



Links command (Edit menu)

Use this command to display a Links dialog box that lets you edit links between your document and
other documents.

This command is unavailable if you have no links in your document.



Links dialog box

This dialog lists the source documents for the active Garden Designer document and provides options
you can use to change the links in linked documents.

Source File
Lists the names of source documents.

Item
Lists the sources of the links.

Type
Describes the linked item.

Status
Indicates whether the link is updated manually or automatically.

Open
Opens the selected source document.

Close
The Close button appears in the Links dialog box when you first open it.
Choosing the Close button cancels the command and closes the Links dialog box.

Change Source
Displays the Change Links dialog box, which you can use to redirect links to the dependent worksheet.

Update Now
Updates the active dependent document with information from the selected source documents.

Automatic
Updates the linked data automatically.

Manual
Updates the linked data manually when you choose the Update Now button.



Object verb (Edit menu)

This command activates an embedded object for editing.

Shortcut
Mouse: Double-click the object with the left mouse button.



Insert New Object command (Edit menu)

Inserts and embeds an object, such as a chart or an equation in a document. The application in which the
object was created becomes active on the screen.

Select the object you want to insert into your document using the Insert New Object dialog box.



Insert New Object dialog box

This dialog inserts a new object into a document and has the following options.

Create New
Select this button to create and embed a new OLE object.

Create from File

Select this button to embed or link an object you have already created and saved using another OLE
application. After you choose Create from File, the File box, the Browse button, and the Link box
appear.

Object Type

Lists the other OLE server applications installed on your computer. Select an object type from the list if
you want to create and embed an object. To embed or link an object you have already created and
saved, choose Create from File.

Display As Icon
Select this box if you want to display the object as an icon.

File
Type the name and path of the file you want to link or embed.

Browse
Opens the Browse dialog box, in which you can choose the file you want to link or embed.

Link
Link the file displayed in the File box. (If you do not choose Link, the file will be embedded.)

Change Icon
Opens the Change Icon dialog box so you can select a different icon.

Change Icon Dialog Box Options

Icon
Select the icon you want to represent an embedded or linked object.

Current
Display the current icon.

Default
Display the default icon.

From File
Type the name and path of the file containing the icon you want to use, or choose Browse to locate the
file.

Label
Enter a label for the icon.

Browse
Locate the file with the icon you want to use to represent an embedded or linked object.



Convert dialog box

In this dialog you can convert an embedded object to another application format. For example if a Garden
Designer document has an embedded Microsoft Excel object and you don't have Excel to convert it to a
format your sheet-processing application can use.

Covert To
Select this radio button to convert the embedded object to the file you specify in the Object Type box.

Activate As
Select this radio button to open embedded objects in the file format you specify in the Object Type box.

Display As Icon
Select this box if you want to display the object as an icon.

Change Icon
Opens the Change Icon dialog box so you can select a different icon.

Change Icon Dialog Box Options

Icon
Select the icon you want to represent an embedded or linked object.

Current
Display the current icon.

Default
Display the default icon.

From File
Type the name and path of the file containing the icon you want to use, or choose Browse to locate the
file.

Label
Enter a label for the icon.

Browse
Locate the file with the icon you want to use to represent an embedded or linked object.



Place menu commands

The Place menu offers the following commands:

Surface Place surface area into plan
Edifice Place edifice object into plan
Fencing Place fencing object into plan
Decor Place decor object into plan
Vehicle Place vehicle into plan
Lantern Place lantern into plan

Surface command (Place menu)

Use this command to place a surface object in your garden plan.

This command displays the Surface Dialog.
For more information about surface objects see Surface Object.

Shortcuts

Plan toolbar:

Keys: Shift+S



Edifice command (Place menu)

Use this command to place a building in your garden plan.

This command displays the Edifice Dialog.
For more information about surface objects see Edifice Object.

Shortcuts

Plan toolbar:

Keys: Shift+E



Fencing command (Place menu)

Use this command to select and place a fencing object in your garden plan.

This command displays the Fencing Dialog.
For more information about surface objects see Fencing Object.

Shortcuts

Plan toolbar:

Keys: Shift+F



Decor command (Place menu)

Use this command to select and place a decorative element within your garden plan.

This command displays the Decor Dialog.
For more information about decor objects see Decor Object.

Shortcuts

Plan toolbar:

Keys: Shift+D



Lantern command (Place menu)

Use this command to select and place a lantern in your garden plan.

This command displays the Lantern Dialog.
For more information about lantern objects see Lantern Object.

Shortcuts

Plan toolbar:

Keys: Shift+L



Vehicle command (Place menu)

Use this command to select and place a vehicle in your garden plan.

This command displays the Vehicle Dialog.
For more information about vehicle objects see Vehicle Object.

Shortcuts

Plan toolbar:

Keys: Shift+V



Plant menu commands

The Plant menu offers the following commands:

Care Display care information about the currently
selected plant species

Diseases Display a list of possible diseases for the
currently selected plant species

Notebook Write/edit notes on the currently selected plant
species

Filter Invoke the plant database filter (encyclopedia
view)

Latin/National names Switch between Latin and National plant
names (encyclopedia view)

Place Place the current plant species into your

garden plan



Care Calendar command (Plant menu)

Use this command to display care information for the currently selected plant species.

This command displays the Care Calendar Dialog.

Shortcuts

Main toolbar:

Keys: F2



Diseases command (Plant menu)

Use this command to view a list of possible diseases for the currently selected plant species.

This command displays the Plant Diseases Dialog.

Shortcuts

Main toolbar:

Keys: F4



Notebook command (Plant menu)

Use this command to write/edit notes on the currently selected plant species.

This command displays the Encyclopedia Notebook Dialog.

Shortcuts

Main toolbar:

Keys: F3



Filter command (Plant menu)

Use this command to bring up the plant database filter.
This command displays the Plant Database Filter.

Shortcuts
Keys: F5



National/Latin names command (Plant menu)

Use this command to switch between National and Latin names of plants.

Shortcuts
Keys: F8



Plant place command (Plant menu)

Use this command to place the currently selected plant into your garden plan.

This command displays the Plant Dialog.
For more information about plant objects see Plant Object.

Shortcuts

Plan toolbar:

Keys: F9



Zoom + command

Use this command to zoom into the current garden plan view.

Shortcuts

Plan toolbar:



Zoom - command

Use this command to zoom out of the current garden plan view.

Shortcuts

Plan toolbar:



Day command

Use this command to display the garden as it would appear in the day time

Shortcuts

Plan toolbar:



Night command

Use this command to show the garden as it would appear in the night time

Shortcuts

Plan toolbar:



Print command (File menu)

In this dialog you will be able to set the number of pages, the zoom and printing area of the garden plan;
and then go on to print it.

This command displays the Garden Print Dialog.

Shortcuts

Main toolbar:

Keys: CTRL+P



Plan Options command (View menu)

Use this command to set garden plan view options.

This command displays the Plan Options Dialog.

Shortcuts

Plan toolbar:

Keys: F7



Month Combo Box

Use the month combo box to select the month in which you would like to view your garden.

By choosing a month, it is possible to see how plants will appear at that time of year with their foliage and
colour variations.
Choose All Colours to view all the plant colours independently of the month.



No background/Window background command (popup menu)

Use this command to switch between the standard window background and a transparent background for
OLE objects.

Some objects ignore this command (for example PaintBrush objects).



Reset size command (popup menu)

Use this command to reset the size of an OLE object to its original size in the server document.



Comments command (popup menu)

Use this command to view and edit an object’s notebook text in the Plan Notebook Dialog.



Properties command (popup menu)

Use this command to view and change an object’s properties in one of the object windows.

Shortcuts
Mouse: double click on the object with the left mouse button.



Replace command (popup menu)

Use this command to change the species of a currently selected plant object.

This command shows the Plant Change Dialog and Encyclopedia window simultaneously.

To change the species of plant, select the appropriate plant in the Encyclopedia and click on the OK
button in the Plant Change Dialog.

To cancel the replacement, click on the “Cancel” button in the Plant Change Dialog.



Care View command (popup menu)

Use this command to view information about the selected plant in the Care Window.

This command shows the Care Window and highlights the currently selected plant object species.



Encyclopedia View command (popup menu)

Use this command to view information about the selected plant object in the Encyclopedia Window.

This command shows the Encyclopedia Window and fills all the fields in this window with information
about the selected plant species.
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Plan Window

This is the main document viewing window.
It contains an editable plan of your garden that can be viewed in day-time or night-time settings, or at
different times of the year!

Above this window you will find the Plan toolbar.
Below the Plan Toolbar and along the left-hand side of the window are Rulers which show the actual size
of your garden design.

Use the Mouse OR CURSOR KEYS to move the cursor within the window area. The cursor will change
according to the current operation:

Program is busy,

Pointing to an object,

Placing an object,

Rotating an object,

Moving an object,
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Resizing an object

To select an object, click on it with the left mouse button.

To select a group of objects click on each object in turn with the left mouse button whilst holding down the
SHIFT key.

To get a popup menu for an object, right click on it, (this will let you change its properties, add comments
to it etc...)

See "Placing an object in a garden plan” for a description of various placing procedures.

Below are described the various object types that you can place in your garden plan:

Surface object. This is an area in the garden plan in the form of a stripe, ellipse or rectangle. There are
many kinds of surfaces available to you (including water) with various borders and interior patterns. Note
that overlapping surface objects with the same border and internal patterns automatically merge, allowing
the generation of complex figures from simple ones (e.g. lawns, roads, beaches etc.).

Edifice object. This object represents an industrial or private construction (eg. building, house, garage,



greenhouse, shed etc.) and sports areas. They are all of a rectangular form, but can be combined with
similar objects to make more complex figures. The default dimensions of sports areas correspond to
international standards, but you can always change the length, width or height of (and rotate) any edifice
object. Height is currently used for informational purposes only.

Fencing object. This object represents an enclosure of various types (e.g. wooden, concrete, stone
fences etc..). You can place fencing in the form of a line, ellipse or rectangle and even adjust the distance
between neighbouring elements.

Decor object. This is one of 30 adornments that you can add to your garden plan (e.g. table, chairs,
barbecue etc..) You can even change the colour of some of them!!

Lantern object. This is an electrical lantern whose effect you can see when viewing the garden plan in a
nightime setting. You can change their power (wattage) and height, to vary the range of light that they
spread.

Vehicle object. This object represents one of 12 vehicle types (e.g. car, bicycle, yacht etc..) For most of
them you can even choose an appropriate colour!

Plant object. This is one of the plants described in the Encyclopedia Window. The plant appearance (the
colour of leaves and presence of flowers) will change in different months: try it by changing the current
month in the Month Combo Box shown in the Plan Toolbar (defaults to saying All colours). Before placing
a plant object you can set the type of planting (single, outline or area) and choose its form (a line or stripe,
ellipse or rectangle). Furthermore, the density of planting can be also be adjusted. For each plant you can
view its care calendar in the Plant Care Dialog and look at the list of possible plant diseases in the Plant
Diseases Dialog. You can view a list of plant types that you have placed in your garden (and a rough
count of their numbers) in the Care Window. In this window you can also check what tasks each plant
needs performing on it throughout the year.

OLE

OLE objects. These are embedded objects that are imported from other applications (for example a
spreadsheet package). You can place and size an OLE object in any part of your garden plan. This object
can be displayed as an icon (see Convert Dialog Box). For most OLE objects (not bitmaps) you can also
select a standard edit window or transparent background (see No Window Background command). An
OLE object is imported from a running application via the Windows Clipboard (Copy/Paste procedure) or
from a file (through the Insert New Object command).
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Care Window

This window contains an alphabetically sorted list of plant species that you have placed in your garden.
The left-most column contains the total number of plants of each species along with a plant type icon
(tree, flower, climber, aquatic plants, etc..). A scrollable group of columns on the right-hand side of the
window contain up to four plant care icons for each month: showing what tasks should be performed on
each plant in each corresponding month.

Months scroller
On the top row of the window you will see a left and a right arrow button. Use these to scroll the
months columns displayed in the window.

Plant total column
Contains the total number of plants of each given species in your garden plan

Plant name column
Contains the full name of the plant. The type of name displayed (Latin or National) is determined by
the current selection within the "Encyclopedia” window.
Double click on the name to view this plant’s information in the "Encyclopedia” window. Note that if
you have turned on a filter in that window, you will see this plant’s details, but it will not appear in the
list of plants in that window.

Months columns
Contains care icons for each month.
Click on an icon to view brief care information in a Gardening Dialog.

Note that you can print a care calendar for the leftmost displayed month by using the File|Print menu
entry or clicking on the printer button on the toolbar. Use File|Print Preview to see what this will look like.
To obtain a printout of the last months in the year (e.g. December), you will need to resize your display
window so that only one column month is displayed... then scroll to the required month and make a
printout.
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Notes Window

This window represents a simple text editor for keeping notes about your garden.
The text is saved within the Garden Designer document file (a file with extension "GRD").

Note text can be printed on your printer, by using the File|Print menu item, or by clicking on the printer
button on the toolbar.

Text can be copied and pasted to and from other applications, using the standard windows clipboard
commands. Note that you will need to select the text that you wish to copy from the Notes Window before
copying it onto the clipboard.



Encyclopedia Window

This window contains information on more than 1000 species of plants.

Here it is possible to retrieve information about any plant, to choose plants based on certain criteria, to
look at potential diseases that each plant might suffer from, and how to take care of a given plant.

For the currently selected plant:

To view a list of possible plant diseases use the Diseases command.
To view the care calendar use the Care Calendar command.

To add\edit your own notes on that plant use the Notebook command.

You can print an image of the Encyclopedia window using the Print command.

You can use the Plant Filter to select a smaller group of plants based upon certain criteria.
You can place the currently selected plant in your garden plan using the Place button .

The various information and control fields of this window are:

List of plants
Contains all the plants that were filtered by the Plant Filter. The list is ordered by the National or Latin
plant name. You can switch between Latin and National names by using the Latin/National command
or Latin/National button. Selecting an item in the list, by clicking on it, results in all the information
fields being updated with that plant’s details. Having selected an item in the list you may scroll through
the list using the up and down arrow keys and page buttons.

Search edit field
Appearing above the list of plants, this edit field allows you to enter the first letters of a plant name to
be selected within the list of plants.

Name of the current plant
This displays the Latin or National name of the currently selected plant within the plant list

The picture of the plant
Certainly the picture is only a pale reflection of the bright colours found in nature, but it offers a general
representation of the plant.

Plant picture buttons
Appearing beneath the plant picture, these buttons give you the choice of viewing additional pictures
for the currently selected plant (if available).

View from above
This is a representation of how the plant will look when viewed from above. This is how the plant will
be appear when placed within your garden plan.

Plant silhouette.
This image presents a plant profile or tree skeleton, along with sizings (in metres) of the typical height
and spread of that plant.

Season colour diagram
The outer circle shows which months the plant blooms in and the colour of its flowers. The inner circle
indicates when the plant has foliage and what colour its leaves are.



Plant usage buttons
Contains all possible usage's of a given plant within your garden and home. Click one of buttons to
view brief usage descriptions in the Plant Usage Dialog .

Place button
Click on this button to enter the Plant Dialog and place the currently selected plant within your garden.

Filter button
Click this button to invoke a Plant Filter and select a subset of plants based upon various criteria.

Latin/National button
Press this button to switch between National and Latin plant names in the plant list.

Plant height scale
This slider indicates the plant height (in metres). For trees it is maximum height reached in Europe, for
others the height during the blossoming period. The plant reaches the mentioned height at maturity
and under favourable conditions!

Plant width scale
This slider indicates the average width of plant (in metres). The plant reaches the mentioned width at
maturity and under favourable conditions. For bushes and flowers it depends on how they are pruned.

Plant Type
This information field contains a plant type icon showing the type of the currently selected plant.

Watering
This information field contains a watering icon showing how much water the currently selected plant
prefers.

Lighting
This information field contains a light exposure icon.to show how much light the currently selected
plant prefers.

Temperature
This information field contains a temperature icon to show the level of warmth that the currently
selected plant prefers.

The type of ground
This information field contains a soil icon showing the preferred soil type for the currently selected
plant. If the soil in your garden is different from the one shown, you may dress your soil with various
treatments to enhance conditions for these plants

Hardiness zone range
This text field shows the range of Rheder's hardiness zones in which the currently selected plant will
grow. Zones are numbered from 1 to 10. Zone 1 corresponds to a sub-arctic climate, zone 10 to a
subtropical climate!

Plant Lifetime
This text field indicates the average lifetime of a plant in years. For trees it is maximum lifetime under
favourable conditions. For other plants it is best growing time between division or other such renewal.



Plant Filter

Use this window to filter out unwanted plants and reduce the Encyclopedia’s plant list by selecting various
criteria.

All the icons and scales in this window represent plant selection criteria. Each group of icons and each
slider corresponds to single criteria (e.g.: the plant watering icon group, plant lifetime slider).

Ticked icons and slider thumb positions indicate the possible properties of the selected plants. If some of
icons disappear, it is as a result of no such plants being selectable with the current criteria, (e.g. selecting
minimal water will cause the climber button to disappear: this is because there are no climbers that
accept minimal watering!)

If you select more than one icon within a single group, then all plants with any of the ticked properties will
be selected, (e.g. selecting maximum light and medium light will end up excluding all plants that don’t
flourish under minimal light conditions).

Another example; if you click on yellow and red in the colour selection list, then all plants with yellow or
red flowers will be selected.

If icons/sliders in different groups are ticked/moved, then plants that satisfy all the selected criteria will be
selected. For example, if you set the thumbs of the plant height slider in positions 1 and 3 metres, and
click on "TAUG" in the circle diagram, and then click on the "Fragrant plant”" button, then only plants 1-3
metres tall that blossom in August and smell pleasantly will be selected!

To change the criteria on sliders, move their thumbs to the preferred position. To change the criteria of
button groups, click on an icon or press the space bar when the focus frame is around it. Selected icons
are indicated by a red tick mark; selected buttons are shown as a “pushed down button’. To deselect a
button or icon, click on it again.

Use the following buttons to:
"OK" - close the window, saving the current filtering.
"CANCEL" - close the window and reject filtering changes made.
"RESET" - cancel the all selection criteria and reset filtering to show ALL plants.

The following window fields control plant selection criteria:

Type group
Select plant types by selecting one or more type icons.

Watering group
Select plant watering conditions by checking one or more watering icons.

Lighting group
Select plant light exposure conditions by checking one or more lighting icons.

Temperature check group
Select plant temperature conditions by checking one or more temperature icons.

Soil check group
Select plant soil conditions by checking one or more sail icons.



Flower and Leaf circle diagram
The various sectors of this diagram correspond to months. The outer (red) circle indicates the TOTAL
blossoming months of all the currently selected plants, the inner (green) circle indicates the TOTAL
months of foliage of all the currently selected plants. With ALL plants selected by the filter, you will see
that the database contains no plants that bloom in January!
You can select the preferred foliage or blossoming months by clicking on the month abbreviations
around the edge of the circle. Selected months are indicated by a white rim.
For selecting blossoming months enter “flower mode’, for selecting months of foliage switch to "Leaf
mode’. Use the "Leaf/Flower button" to switch between these modes.

Leaf/Flower colour selection list
This list contains 5 leaf colours in Leaf mode and 10 flower colours in Flower mode. Use the
"Leaf/Flower button" to switch between these modes. To select one or more flower or leaf colours click
on the required colour with the left mouse button. If some colours are disabled it means that there are
no such plants which have this colour, and match the other selection criteria.

Leaf/Flower switch button
Click this button to switch between Leaf and Flower mode.
This allows the colour and circle diagrams to be used to select criteria for both leaves and flowers. The
currently displayed picture on the button indicates which mode the button is in:
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- Leaf mode,

- Flower mode.

Plant height slider
By moving the thumbs of this slider up and down you can set the selection of plants to have a height
within the indicated range. If these have not been moved, then selecting other criteria will move them
automatically to show the height range within that selection.

Plant lifetime slider
Use this to choose the average lifetime of plants in the current selection. If it has not been changed,
then selecting other criteria will move it automatically to show the age range of plants within that
selection.

Usage buttons
This group contains buttons for all possible plant uses within your garden and home. Click on one or
more buttons to select plants by usage. If you select more than one button, then the plant selection will
have plants that meet at least one of the selected criteria.
If some buttons are disabled, it means that current set of selected plants does not contain any plants
that have such a usage.

Hardiness zone slider
Using this slider you can select the range of Rehder's hardiness zones that you wish your plants to be
capable of living within. Zones are numbered from 1 to 10. Zone 1 corresponds to sub-arctic climate,
zone 10 to subtropical climate.

Hardiness zone map
This map shows the selected hardiness zones in a light green colour.
A light brown colour indicates an area in which no plants within the current selection are capable of
growing.

Quantity of selected plants
This field shows total number of plants satisfying your selection criteria. When you first enter this
dialogue box it indicates the number of plants filtered by previous use of the Plant Filter.



Reset button
Click this button to reset any filtering and view all plants in the database.



Plant type icons
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Deciduous trees.

Fii
Coniferous trees.
id

Bushes (deciduous & coniferous).

T

Flowers.
i

Herbs and grasses.

%)

Climbers.



Watering icons
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Constant watering. For plants living in wet places or growing by the edge of lakes, rivers and
streams. Such plants need moisture rich soils.

i3

Occasional watering. For plants which need watering only during dry periods, eg. trees and lawns.

e,

Watering not required. For plants which prefer arid conditions. They require good drainage and won't
endure excess moisture.




Lighting icons

Full shade. For plants which require shade. Such plants grow badly in open places.

L

Half shade. For plants which grow in open sunlight, or with some shade.

]

Open place (Full sunlight). For light-loving plants which do not grow well in the shade.




Temperature icons
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armth-loving plants. Plants that grow best in warm conditions.

Moderate temperature. Plants that can endure short, mild frosts.

Frost-resistant plants. Plants that can endure the hardest of frosts. Such plants don't require
covering up during the winter.



Soil icons

Sandy soil. For plants that require friable, but not rich soils.

Lime soil. For plants that prefer lime soil and a high pH value.

Peat soil. For plants that prefer friable and sour soils. Mulching soil with peat will improve its quality for
such plants.

=

Clay soil. For plants that require dense and moisture retaining soils.

e

Stony soil. For plants that require good drainage.



Care Calendar Dialog

In this dialog you can view monthly care information about the currently selected plant species. The plant
care information is organised as a table, months listed in columns and rows for the various operations.

The icons show which gardening operations the currently selected plant needs in any given month.
Clicking on an icon with the left mouse button displays the Gardening Dialog window with more
information about this task.



Gardening Dialog

This dialog shows information about a selected garden care operation. The image on the left shows an
overall view of the gardening operation, whilst the text on the right describes various steps and conditions
for the operation.

If the Animate button is enabled, you can watch an animation of the image by clicking on that button. Click
on the Stop button to stop the animation once it is running.



Encyclopedia/Plan Notebook Dialog

In this window you can view and edit notes on the currently selected plant species.

Any notes you make whilst in the Encyclopedia are stored in a database separate to the gardening files,
and can thus be viewed in any garden that you might create/load in the program.

The notes made for objects within a garden are unique to that object and are saved within the garden
database file.

Click on the "Save" button to save any changes made to text and close the dialog.

Click on the "Close" button to close the dialog without saving any text changes.



Plant Diseases Dialog

The Diseases window shows a list of possible diseases for the currently selected plant.

When a list item is selected, the view on the left changes to show an illustration of the disease.



Plant Usage Dialog

The Plant Usage window shows selected plant usage information.
The picture on the left illustrates the usage described in text on the right side of the dialog.

This window pops up when clicking on a usage button in the Encyclopedia Window or double clicking on
a usage button within the Plant Filter.



Plant Dialog

In the Plant dialog you can set placement options for a Plant object.
It is possible to choose single or group planting, and to set the density and configuration of the planting.

Seeding buttons.
Click on one of these buttons to select one of the following seeding types:

Single planting. Only one plant will be planted. "Spacing" and "Shape" will then be disabled.

Outline planting. Plants will be placed in a line, around an ellipse or around a rectangle in the form of a
chain. This seeding type is most suited to flower beds and borders.

Area planting. Plants will fill all the space within an object.

Spacing slider
Use this slider to set the density of planting (the distance between neighbouring plants) in the range 0
to 3 metres.

Shape buttons
Click on one of the buttons to select one of following shapes of plant object:
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Ellipse,
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Rectangle.

To place an object with the selected properties click on the "OK" button. The Plan Window will then enter
a Place mode.



Surface Dialog

In the Surface dialog you can set the properties of a Surface object.

Here you can setup up garden paths with borders, lawns and ponds and then include them in your garden
plan.

Width slider
This slider sets the width of your object. you can vary it in the range 0.5-20 metres.

Border slider.
This slider sets the width of a border to your object in range 0 to 2 metres. Setting this to zero removes
the border.

Shape buttons
Pressing one of those buttons you can select one of the following surface shapes:
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Rectangle.

List of surfaces
This list contains more than 40 surface types with several different interiors and borders.

Place Over button.
Click on this button to place the surface on top of other surface objects. Usually the overlapping
surfaces are placed in the order they appear in the surface list (like objects being merged together),
later items in the list on top of earlier items in the list. This button changes this order of surface
overlapping. This doesn’t allow you to place surface objects on top of other objects such as decor
objects!!

To place an object with the selected properties click on the "OK" button. The Plan Window then enters
one of the Place modes.



Edifice Dialog

In the Edifice dialog you can set the properties of an Edifice object.
Here you can choose a building object or sports area to be included on your garden plan.

Length, Width and Height sliders
Ranges of sliders are:
Length -- from 1 to 200 metres;
Width -- from 1 to 200 metres;
Height -- from O to 15 metres (height used for information purposes only)

To place an object with the selected properties click on the "OK" button. The Plan Window then enters a
Rectangle placing mode.



Fencing Dialog

In the Fencing dialog you can set the properties of a Fencing object.
Here you can choose the type of fencing, its shape and set the spacing between neighbouring elements.

Shape buttons
Pressing one of these buttons to select the shape of the fence object:

Line,

Ellipse,
=

Rectangle.

Spacing slider
Set the distance between neighbouring fencing elements from 0 to 3 metres. A value of zero will give
you a solid fencing outline.

To place an object with the selected properties click on the "OK" button. The Plan Window then enters
one of the Place modes.



Lantern Dialog

In the Lantern dialog you can set the properties of a Lantern object, its power and height.

By viewing the garden in night mode you can then check the placement and setting of lanterns by their
lighting area.

Power buttons.
Here you can choose the power of your light.
The button values are: 60, 100, 200, 500 and 1000 watts.

Height slider.
The height slider indicates the lantern height above the ground: you can vary this value from 0 to 5
metres. Changing the height changes the spread of light!

To place an object with the selected properties click on the "OK" button. The Plan Window then enters the
Single place mode.



Plan Options Dialog

In the Plan Options dialog you can set various viewing options for your Plan window: day/night time, view
month, guide grid, display area and zoom factor. These are saved with your garden design.

Time slider
Use the Time Slider to set the time of day for viewing the plan (day or night). In Night mode you can
view the lighting area of Lantern Objects.

Zoom Slider
Use the Zoom Slider to set the required zoom size. The slider indicates the dimension of garden area
visible in the Plan Window.

Months list
By choosing a month it is possible to see how plants will look at this time year and to view their
corresponding colours.

Grid Slider
Using this slider you can set the size of the guide grid for your garden plan. Size "0 is off.

“Show’ icons
Tick these icons to select what is or is not displayed within your garden plan. This is useful if you want
to look at only certain aspects of your garden, e.g. the flowers.

trees (higher than 1 metre),

flowers (beneath 1 metre),

paths,

buildings,

fencing,
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single objects (vehicle, lanterns or decor objects).
Ared check mark indicates that a given set of objects is visible.

Animate drawing icon.

When this icon is ticked, you will see objects drawn in the Plan Window a layer at a time. Deselecting
this gives faster drawing speeds.

Plan navigation window
The left pane shows a plan on the entire garden. The navigation frame indicates the plan area that will
be visible in Plan Window with the current zoom. Use the mouse or arrow keys to move this frame
around within your garden plan; thus changing your view when you return to your Plan Window.



Garden Print Dialog

In the Garden Print dialog you can set the number of X and Y pages used to print out your garden plan,
their relative position to your garden and the zoom factor for printed pages. Having done this you can
then print straight away, or preview what the output from the program will appear like on your printer.

Printing area view
The left side of the dialog shows a miniature garden plan. The frames on it indicate the printing area
divided into pages. Use the mouse or arrow keys to change the page locations relative to your garden
plan.

Horizontal pages (X-direction)
This slider sets number of pages along the horizontal direction. The range is from 1 to 7 pages.

Vertical pages (Y-direction)
This slider sets number of pages along the vertical direction. The range is from 1 to 7 pages.

Page zoom
The slider sets the page zoom factor from 1 to 30.

Print preview button
Click on this button to get a Print Preview.

Print setup button
Click this button to bring up the Print Setup dialog.



Plant Change Dialog

The plant change dialog allows you to change one plant species for another.
Select the new plant species in the Encyclopedia and then click OK button in the Plant Change Dialog.
To cancel the replacement operation, click on the CANCEL button in the Plant Change Dialog.

This dialog appears as a result of selecting the Replace command from an object popup menu.



Plant Image Dialog

The plant image window shows an image of the plant as seen in nature.

Click on the CLOSE button to close this view.



Decor/Vehicle Dialog

In the Decor/Vehicle dialog you can set properties for a Decor or Vehicle object.

Colour buttons
Use these buttons to choose the colour of your Decor/Vehicle objects.

To place an object with the selected properties click on the "OK" button. The Plan Window then enters
one of the Place modes.



Object general view

This area gives a general view of an object.



View from above

This area shows how your plant will appear in your garden plan.



"OK" button

Press this button to accept changes made and close the window.



"CANCEL" button

Press this button to cancel changes made and close the window.



Object type list

This list box contains different object types.

To quickly search for an item by its first letter, type the corresponding letter on the keyboard.



Plant name

This field contains the name of the plant species.



Plan Background Dialog

Choose one of the plan background patterns or colours in the list.
The left side of the dialog shows a sample of the background selected.

Press OK button to accept the selection.
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General description of Garden Designer

Garden Designer is a computer plant encyclopedia and garden planner.

Using the encyclopedia you may select plants by various criteria (colour, flowering time, fragrance etc..)
and place them in your garden plan. The flowering and foliage calendar also allows you to choose plants
according to when they flower and bear leaves, and the colour of their flowers or leaves.

The encyclopedia contains information on over 1000 plants. Information is based on 25 parameters (such
as form, size, colour) and. each plant is illustrated with at least one colour picture.

For each plant, up to 15 possible diseases that it might suffer from are catalogued.

For each plant there is a full care calendar, indicating what gardening tasks it requires and when. Some of
these are even illustrated with animation sequences.

You can build up the design of your garden using the simple elements, (e.g. fences, paths, ponds), and
then print it out as a record.

With help of this program you can also see what the change in flower and leaf colours will be for different
months of year.

The program can also allow for garden lighting and illustrate how your garden will look at nightime.

Some of the key components and features of Garden Designer are detailed below:

Garden planner (Plan Window) is a graphic editor, specially developed to produce plans for gardens and
parks. The editor uses realistic images of garden objects to produce a viewed from above plan of your

garden. The main editing features include:
Placing/deleting objects;
Automatic overlapping and merging of objects;
The scaling and rotation of objects;
The saving/loading of garden plans;
Scrolling of garden plans;
The smooth Zoom feature;
Viewing the garden in different months;
Viewing the garden at night or during the daytime;
Guiding grid placed over the plan;
The selective display of objects on plans;
Compatibility with OLE 2 standards.

Encyclopedia of plants (Encyclopedia Window) containing information about all the plants in Garden

Designer. It contains the following data:
The name - National and Latin classification;
The appearance - (Image of size 200 * 200 pixels 256 colours);
View from above for the garden plan of scale 1:100;
Silhouette - a monochrome depiction 100 * 137 pixels;
The type of plants - deciduous and coniferous trees, bushes and hedges, herbs, grasses, ferns, climbers;
Light, moisture and temperature requirements
Height, width and life expectancy information;
What the plant can be used as;
The periods of flowering and leaf bearing;
The colour of flowers, leaves, and autumn leaves;

The plant filter (Eilter Window) helping to select plants based upon your entered criteria. Selection can
be performed on all the information fields held by the encyclopedia.

Garden maintenance information (Care Window) listing all tasks required for plants in YOUR garden.
Plant care information (Care Calendar Dialog); an annual calendar for garden work required by each

plant. Garden tasks are illustrated by small icons. Additional textual and graphic information is available to
illustrate how to carry out this operation.



Plant diseases (Plant Diseases Dialog); lists diseases which may affect individual plants.

Notebook (Encyclopedia/Plan Notebook Dialog and Notes Window); allowing you to write comments on
the garden, plants within the encyclopedia, or any individual object or plant in your garden plan.



Changing the current plant species

The current plant species is the one that was last selected in one of document windows. All the plant
operations, obtained through the Plant menu or plant buttons (,

) of the Main Toolbar, are with respect to this current species.

You change the current plant species when you select a plant object in the Plan Window or select a plant
name in the Encyclopedia Window or Care Window.

Each window can retain its own current plant selection when switched between.

Alternatively you can synchronize different windows to all show information on the last plant you selected
anywhere in the program through the Synchronize by plant setting. For example, bringing up a plan and
encyclopedia window allows you to select various plants in your garden plan, and have the encyclopedia
show corresponding information.

To turn this Synchronize mode off, select the "Synchronize by plant” setting.



Viewing the care calendar for the current plant species

You can view the care calendar of the current plant species in the Plant Care Dialog.

To invoke this dialog, use the Care Calendar command from the plant menu.



Viewing diseases for the current plant species

You can view potential diseases for the current plant species in the Plant Diseases Dialog.

To invoke this dialog, use the Plant Diseases command from the plant menu.



Viewing and editing note text for the current plant species

You can view and edit plant species note text in the Encyclopedia Notebook Dialog.

To invoke this dialog, use the Notebook command from the plant menu.



Placing an object in the garden plan

To place a new object in your garden plan click on the button on the Plan Toolbar or menu item in the
Place menucorresponding to the type of object you want to place.

After choosing your objects properties, click on the "OK" button in the object dialog.

The Plan Window then enters one of following placing modes according to the object type and its shape:

Placing of a single object
In this mode an image of the object appears (e.g. single plant, decor element, vehicle) with the mouse
cursor in the bottom-right corner. To place the object:

With no mouse buttons pressed, drag the object to the position you require.

Drag whilst holding down the right button if you need to rotate the object (NB. some objects can not be
rotated).

Click the left button to actually place the object.

X

To cancel the placing operation press the "Esc" key or double click the right mouse button.

Placing an ellipse/rectangle
In this mode an outline of the ellipse/rectangle of the chosen dimensions appears with the mouse
cursor in the bottom-right corner. To place the object:

With no mouse buttons pressed, drag the object to the position you require.

Drag whilst holding the left mouse button to change object width and/or height.

Drag whilst holding down the right mouse button to rotate the object.

Click the left button to actually place the object.

X

To cancel the placing operation press the "Esc" key or double click the right mouse button.

Placing a linelstrip

In this mode the cursor appears differently: . To place the object:

Move cursor to your layout starting point.

Drag with the left mouse button held down to extend the line/strip. The outline of a line/stripe will appear.

Alternatively you can point out the start and end points of line. Do this by dragging with the left or right
mouse buttons held down.

You can also transform a line into a curve by dragging with left and right mouse buttons held down
simultaneously.



Move the mouse with no buttons held down to move a configured line.

Click the left hand mouse button to finish and confirm placing.

X

To cancel the placing operation press the "Esc" key or double click the right mouse button.



Transforming an object

To transform an object select it first. Then enter transform mode by clicking on the object, dragging with
the left button still held down, and then releasing the button.

Depending on its form, the object enters one of several transform modes that are similar to the placing
ones:

Transforming a single object
In this mode an image of object (single plant, decor element, vehicle) appears with the mouse cursor
in the bottom right corner. You can move an object and rotate it (if rotation is allowed for this object
kind) in the following ways:

To move the object move the mouse with no mouse buttons depressed.
To rotate the object drag whilst holding down the right mouse button.

To finish and confirm the transform operation click on the left mouse button.

X

To cancel the transform operation press the "Esc" key or double click on the right mouse button.

Transforming an ellipsel/rectangle:
In this mode an outline of the ellipse/rectangle appears with the mouse cursor in bottom right corner.
You can move, resize, and rotate the object in following ways:

To move the object move the mouse with no buttons depressed.

To resize the object drag with the left mouse button held down.

To rotate the object drag with the right mouse button held down.

To finish and confirm the transform operation click on the left mouse button.

X

To cancel transform operation press the "Esc" key or double click on the right mouse button.

Transforming a line/stripe
In this mode an outline of a line/stripe appears. You can move the object, point out new start and end
points, or bend the line/stripe in the following ways:

To move the object move the mouse with no buttons depressed

To point out new start and end points drag with the left or right mouse button depressed.

To bend the line move the mouse with both the buttons depressed at the same time.



To finish and confirm the transform operation click on the left mouse button.

To cancel the transform operation press the "Esc" key or double click on the right mouse button.



Selection of an object or group of objects

Single garden object: click on it with the left mouse button.
Group of objects: You can select a group of objects in ways:
1. Hold down the "Shift" key whilst clicking on all desired objects.

2. Place the mouse cursor on an empty part of the garden, and drag out a “lasso” whilst holding down
the left mouse button. On releasing the left mouse button, all objects within the lasso area will be
selected.

Selected objects are indicated by a red shading.
Previously selected objects will be deselected when a new selection is made.

To remove a selection in the garden plan use the Deselect command.



Copying objects

First you need to select an object or group of objects.

You can copy selected objects in two ways:

1. Holding down the "Ctrl" key, click and drag a copy of the selected object away from it. To copy a
group of objects, hold down the "Ctrl" and "Shift" keys simultaneously. To cancel the Drag and Copy
operation, press the "Esc" key or double click the right mouse button

2. Select the Copy command from the edit menu to copy the selected objects onto the Clipboard. Then
choose the Paste command to paste objects from the clipboard into the garden plan. New objects will
be pasted on top of the source objects and become selected. See "Changing placement and
orientation of objects" for a description of how to move the pasted objects to a new place.



Viewing & changing the properties of an object

You can view and edit object properties in one of the object dialog windows (e.g. Edifice Dialog).
Such a dialog can be brought up in two ways:
1. Double click on the object with the left mouse button.

2. Click on the object with the right mouse button. The object’s popup menu will appear. Select the
Properties command from the object submenu.



Changing placement and orientation of objects

First You select an object or group of objects.

Click and drag on an object it with the left mouse button, release the mouse button and then move the
object. If you are moving a group of objects, hold down the "Shift" while initially clicking and dragging.

Whilst moving an object/group of objects you can rotate it/them by dragging with the right mouse button
held down.

To confirm and finish the operation, click on the left mouse button at the final destination.

To cancel the Move/Rotate operation, press "Esc" key or double click on the right mouse button.



Viewing and editing object notes

You can view and edit object note text for any object in the Plan Notebook Dialog.

To bring up this dialog click with the right mouse button on the object; the object’s
popup menu will appear.
Select the Comments command from the object type submenu.






